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This beginning level AutoCAD  was developed to be used as a textbook for 
courses I was teaching on the College level in and around metropolitan Boston.

The clear challenge was to o�er a streamlined method of instruction that 
allowed the users to become quickly pro�cient withe ‘basic’ core commands in 
order to prepare a 2D drawing.



Interacting with AutoCAD

AFTER COMPLETING THIS CHAPTER, YOU WILL BE ABLE TO:

Launch AutoCAD �

Maneuver the user interface �

Understand how to interact with AutoCAD �

CHAPTER 1 
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2 ■  CHAPTER 1 : INTERACTING WITH AUTOCAD

FIGURE 1.2:  Ω Launching AutoCAD via the Start menu

At startup, AutoCAD will launch a New Features Workshop window. This window 

will give you the option to view or not view the new features of the software and 

to keep the window from launching at startup. The New Features Workshop (Fig-

ure 1.3) can also be accessed using the Help menu at any time. To continue launch-

ing your session of AutoCAD, follow these steps:

 1. Click the No button with the left mouse button.

 2. Click the OK button with the left mouse button.

AutoCAD 2008’s new features will be discussed in a later chapter.

A new AutoCAD drawing session will launch. This drawing session will typi-

cally launch in the 2D Drafting and Annotation AutoCAD Workspace (Figure 1.4). 

This workspace contains the new toolbars and features associated with the current 

release.

Launching AutoCAD

Autodesk, the makers of AutoCAD, usually release a new version of the software 

every year. With each new release, the software becomes more streamlined to 

make it easier to use. New toolbars and functions are also added to enable the user 

to work more efficiently. The overall interface is not markedly different between 

the versions. If you are using AutoCAD release 2006 or 2007, you should be able to 

quickly adapt, although your screen interface will not have the newest functions of 

the current release. Regardless of the release you are using, understanding how to 

interact with AutoCAD is important.

Launching AutoCAD via the Shortcut Icon

AutoCAD is launched similarly to other Windows-based software applications: either 

via the shortcut icon on your computer’s desktop or the Start menu. (See Figure 1.1.) 

To launch AutoCAD via the shortcut icon, do the following:

Double-click the AutoCAD shortcut icon with the left mouse button.

FIGURE 1.1:  Ω Launching AutoCAD 
via the shortcut icon

Launching AutoCAD via the Start Menu

To launch AutoCAD using the Start menu, do the following:

 1. Click the Start menu (Figure 1.2) with the left mouse button. 

 2. Select All Programs with the left mouse button. Navigate to the Autodesk 

folder and click it with the left mouse button.

 3. Select AutoCAD 2008 or the version of the software that is currently loaded on 

your computer. Click the left mouse button.

This action will launch a new session of AutoCAD.
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STARTING A NEW SESSION OF AUTOCAD  ■ 3

Because users have different releases of AutoCAD, these examples will launch 

the AutoCAD Classic Workspace (Figure 1.5). This workspace launches similarly to 

past releases of AutoCAD. To launch this workspace, do the following:

With the left mouse button, click the AutoCAD Classic Workspace selection 

from the Workspaces toolbar.

FIGURE 1.5:  Ω The AutoCAD Classic Workspace

Starting a New Session of AutoCAD 

To start a new session of AutoCAD using the pulldown menu, follow these steps:

Click File and select New with the left mouse button.

To start a new session of AutoCAD using the command line, follow these steps:

Type new and press the Enter key on the keyboard, or click the right mouse 

button (right-click) and select Enter from the tooltip window.

FIGURE 1.6:  Ω The New Drawing icon

FIGURE 1.3:  Ω The New Features Workshop window

FIGURE 1.4:  Ω The 2D Drafting and Annotation AutoCAD Workspace
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4 ■  CHAPTER 1 : INTERACTING WITH AUTOCAD

The Save As Function

To save a file using the pulldown menu, do the following:

Click File and select Save As with the left mouse button.

To save a file using the command line, do the following:

Type Save and press the Enter key on the keyboard, or click the right mouse 

button and select Enter from the tooltip window.

To name and save your drawing file, do the following:

 1. Click the File pulldown menu and select Save As with the left mouse button. 

The Save Drawing As window will launch, as in Figure 1.8.

 2. Navigate to the appropriate folder on your computer.

 3. Name your file Review-Ch1 by entering the information in the File Name area.

 4. Click the Save button with the left mouse button.

These steps will save your drawing file to the folder that you selected. This is 

critical because every 10 to 15 minutes AutoCAD will back up your drawing once it 

has been saved using a default setting. 

FIGURE 1.8:  Ω The Save Drawing As window

Selecting a Template

Now that the software has been launched, start a new drawing file using a template. 

The software comes with many default templates already added. To access these 

templates, do the following:

 1. Click the File pulldown menu and select New with the left mouse button. A 

Select Template window will launch, as in Figure 1.7.

 2. Select the acad or acad.dwt template with the left mouse button.

 3. Click the Open button with the left mouse button.

This action will start a new drawing file.

FIGURE 1.7:  Ω The Select template window
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STARTING A NEW SESSION OF AUTOCAD  ■ 5

Setting Drawing Limits

To set drawing units using the pulldown menu, do the following:

Click Format and select Drawing Limits with the left mouse button.

To set drawing units using the command line, do the following:

Type limits and press the Enter key on the keyboard, or type limits and 

right-click.

Drawing limits are usually set so that objects drawn will be scaled to fit on your 

display. Drawing limits are based on the ultimate page size of your final drawing. The 

ultimate page size will be dictated by the overall size and dimensions of your draw-

ing. For example, if you are drawing a 100,000 square-foot floor plan, obviously, it 

will not fit on an 8½˝ × 11˝ page size at an acceptable scale. 

Floor plans are generally drawn at a scale of 1⁄8˝=1´-0˝ or ¼˝=1´-0 ,̋ and elevations 

are drawn at a scale of ¼˝=1´-0˝ or ½˝=1´-0 .̋ Therefore, you will need to take into 

account the size of your project and the drawing scale prior to setting the drawing 

limits. However, it is possible to draw outside the drawing limits. To set the drawing 

limits, do the following:

 1. Click Format and select Drawing Limits with the left mouse button. 

Command Line Prompt:

Command: Reset Model space limits:
Specify lower-left corner or [On/Off] <0’-0”,0’-0”>:

 2. Press the Enter key on the keyboard, or right-click and select Enter from the 

tooltip window. 

Command Line Prompt:

Command:  Reset Model space limits:
Specify upper-right corner <1’-0” ,0’-9”>:

 3. To enter a drawing limit for a page size that is 24˝× 36 ,̋ do the following:

Type 36,24 on the command line and press the Enter key, or enter 36,24 and 

right-click.

Your drawing limits will be set and the command will end.

Setting Drawing Units

To set drawing units using the pulldown menu, do the following:

Click Format and select Units with the left mouse button.

To set drawing units using the command line, do the following:

Type ddunits and press the Enter key on the keyboard, or right-click and 

select Enter from the tooltip window.

Next, the drafting units will need to be set for your drawing. In order to set them 

to architectural units, do the following:

 1. Click the Format pulldown menu and select Units with the left mouse button. 

A Drawing Units window will launch.

 2. In the Length section, click the Type pulldown menu, and click Architectural 

with the left mouse button.

 3. Click the OK button with the left mouse button.

This action will set your drawing units to architectural and close the Drawing 

Units window. (See Figure 1.9.)

FIGURE 1.9:  Ω The Drawing Units window
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6 ■  CHAPTER 1 : INTERACTING WITH AUTOCAD

The software Control buttons (Figures 1.12 and 1.13) control the operation of the 

session. The top series of buttons within the current-drawing name band controls 

the AutoCAD session, and the buttons directly below them control the current 

 drawing session. The left button will minimize the current session, the middle but-

ton will maximize the current session, and the right button will close the current 

session.

FIGURE 1.12:  Ω The Control buttons — 
AutoCAD Session

FIGURE 1.13:  Ω The Control buttons — 
Current drawing session  

The toolbar in Figure 1.14 allows access to all of the commands and procedures. 

Using the pulldown menus is only one way to execute commands.

FIGURE 1.14:  Ω The pulldown menus

The Info Center toolbar (Figure 1.15) allows you to access to the AutoCAD Help 

menu.

FIGURE 1.15:  Ω The Info Center toolbar

The Standard toolbar (Figure 1.16) is typically launched at startup and includes 

many of the standard icons.

FIGURE 1.16:  Ω The Standard toolbar

The Drawing toolbar (Figure 1.17) contains the basic drawing command icons.

FIGURE 1.17:  Ω The Drawing toolbar

Maneuvering the User Interface

Before you can create any drawings, you must be familiar with the AutoCAD inter-

face (Figure 1.10). Here is a brief overview of its major elements.

Draw Toolbar Modify Toolbar

UCS Icon

Model and Layout Tabs

Pulldown Menus

Command Line Status Bar

Layers Toobar Standard Toobar

Current Drawing Name Control Buttons

FIGURE 1.10:  Ω The AutoCAD interface

Components of the AutoCAD Interface

The band in Figure 1.11 identifies the name of the current drawing file.

FIGURE 1.11:  Ω The name of the current drawing
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INTERACTING WITH AUTOCAD ■ 7

Interacting with AutoCAD

In order to draw 2D drawings, you can use either AutoCAD or AutoCAD LT. The dif-

ferences between the two are slight with regard to preparing 2D drawings. AutoCAD 

LT is a less expensive program with approximately 80 percent of the functionality of 

AutoCAD. Basically, Autodesk removed the 3D capabilities of AutoCAD and some of 

the customization functions, making it considerably more affordable for casual users 

and small firms that don’t need to create 3D drawings or that will use alternative 

software such as SketchUp to prepare 3D drawings.

The following are some useful tips when interacting with AutoCAD.

Naming AutoCAD Files

When you are naming AutoCAD files, take special care when you are using symbols. 

The only symbols that you should use are the following:

The dash (—)• 

The underscore (_ )• 

The period (.)• 

Any other symbols could corrupt your drawing file, rendering it useless. Numbers 

and letters (whether uppercase or lowercase) can be used.

Layers

One of the major benefits of using AutoCAD is that your drawing is composed of 

layers. Typically, geometry is drawn once and subsequent information is added to 

the drawing on separate layers. When a new session of AutoCAD is launched, layer 

0 is the default layer. Think of layer 0 as your main/transfer drawing layer. The Layer 

Properties Manager (Figure 1.24) manages all of the layers and the properties of 

your drawing.

FIGURE 1.24:  Ω The Layer Properties Manager

The Modify toolbar (Figure 1.18) contains the basic modifying command icons.

FIGURE 1.18:  Ω The Modify toolbar

The Model space tab (Figure 1.19) is where you can access the drawing/model 

space of your drawing session.

FIGURE 1.19:  Ω The Model space tab

The Crosshair tool (Figure 1.20) is the selection cursor. 

FIGURE 1.20:  Ω The Crosshair  

The UCS icon (Figure 1.21) identifies the User Coordinate System. The Y-axis is 

the vertical plane, and the X-axis is the horizontal plane. The intersection of the two 

coordinates represents 0,0.

FIGURE 1.21:  Ω The UCS icon

The command line (Figure 1.22) is the area of the screen that allows keyboard 

entry.

FIGURE 1.22:  Ω The command line

The tabs on the Status bar (Figure 1.23) control the status of the drawing aids.

FIGURE 1.23:  Ω The Status bar
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8 ■  CHAPTER 1 : INTERACTING WITH AUTOCAD

To search or recall a toolbar, do the following: 

Hover over any icon visible in your drawing session and right-click. The corre-

sponding toolbar menu will launch. This list will show a check mark next to any 

toolbar that is currently docked in your drawing.

To make a particular toolbar visible, do the following:

Click the name of a toolbar that does not have a check mark with the left 

mouse button.

This action will add the toolbar to your drawing and either dock it to an available 

location or place it in the model space area of your drawing and close the Available 

Toolbar menu. (See Figure 1.26.)

FIGURE 1.26:  Ω The Available Toolbar menu

Model Space

All of the elements of your drawing should be drawn within model space at a 1:1 ratio.

Command Entry

Commands can be executed in many ways. It’s up to you to decide which way is the 

easiest:

Using the command line• 

Using icons• 

Using pulldown menus• 

Regardless of the command-entry method used, it’s important to follow along 

with the command line. The command line will guide you through the steps to per-

form a given function. It’s important to insert information when AutoCAD prompts 

you and then press the Enter key to continue. Other prompts to be aware of on the 

command line are items within angled brackets (< >) or regular brackets ([ ]). Inside 

angled brackets are the default settings of the command. To accept the default, sim-

ply press the Enter key. Items enclosed in brackets are options that you can choose. 

These options are keywords, and the first letter of the word is in uppercase. To 

select a particular option, simply type the uppercase letter and press the Enter key. 

New users should watch the command line closely when they are first learning to 

use a tool.

Tooltip Windows

When you are learning to draw, you should try several different ways of entering the 

commands. Using the icons can be the easiest way to execute commands. In order 

to familiarize yourself with the icons, hover your cursor over any icon. A small tooltip 

window will appear, identifying that icon. (See Figure 1.25.)

FIGURE 1.25:  Ω A tooltip window

Available Toolbar Menu

AutoCAD has many available toolbars from which you can choose. Not all of the 

toolbars are visible on your display when the software is first launched. You may 

inadvertently click or move a toolbar and turn it off. 
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INTERACTING WITH AUTOCAD ■ 9

To access the additional functions/options of that icon, do the following:

 1. Click and hold the bottom-right area of the icon at the arrow.

This action will launch the flyout menu and make the other functions/options 

visible.

To choose a different function/option, do the following:

 2. While still holding down the left mouse button, scroll down to another icon 

within the flyout menu and select that icon after it is highlighted and release 

the left mouse button.

This action will start the command for that icon.

FIGURE 1.30:  Ω An executed flyout menu

Clearing a Command

At times you may inadvertently start a wrong command or enter an incorrect prompt 

within a command. To clear or cancel that command, do the following:

Press the Esc key.

This action will stop the running command, enabling you to perform your next 

command. 

Docked/Floating Toolbars

When a new drawing session is launched, default toolbars are docked within your 

display. Docked toolbars (Figure 1.27) are set in the same location every time the 

software is launched. Floating toolbars (Figure 1.28) sometimes appear within the 

model space area of your display. Although floating toolbars can remain exactly 

where they are, it is a good idea to dock them to an available location within your 

display because your viewable drawing space is at a premium. To dock a floating 

toolbar within your display, do the following:

 1. Click and hold the top band of the floating toolbar with the left mouse button.

 2. Drag your cursor to an available space at the perimeter of your display and 

release the left mouse button.

Clicking, dragging, and droppping will dock the toolbar at that location.

FIGURE 1.27:  Ω A docked toolbar

FIGURE 1.28:  Ω A floating toolbar

The Three-Button Mouse

Familiarity with your mouse is key. A three-button mouse enables you to do the 

following:

The • left mouse button will execute a Pick command.

The • right mouse button will execute the Enter command.

The • middle mouse button or the wheel will execute the Zoom or Pan 

command.

Flyout Menus

On any given toolbar, flyout menus (Figures 1.29 and 1.30) contain icons that offer 

additional functions/options of the same command. Any icon that contains a flyout 

menu will have an arrow located at the bottom-right corner of the visible icon.

FIGURE 1.29:  Ω An icon with 
a flyout menu marker
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10 ■  CHAPTER 1 : INTERACTING WITH AUTOCAD

Closing an AutoCAD Drawing

To close an AutoCAD drawing using the pulldown menu, do the following:

Click File and select Close with the left mouse button.

To close an AutoCAD drawing using the command line, do the following:

Type close and press the Enter key on the keyboard, or right-click and select 

Enter from the tooltip window.

To close a drawing session of AutoCAD, do the following:

 1. Click the File pulldown menu and select Close with the left mouse button. An 

AutoCAD Save Changes window will launch.

 2. To save the drawing file, select the Yes button with the left mouse button.

This action will save the changes to your drawing and close the drawing file. (See 

Figure 1.32.)

FIGURE 1.32:  Ω The AutoCAD Save Changes window

AutoCAD Drawing File Extensions

File extensions or suffixes identify a file’s format. With AutoCAD there are several 

file extensions that you may encounter. However, the two most common are .dwg 

and .bak.

Repeating Command Entries

You may need to end commands and restart them again, one after another. Although 

it is possible to access the command via the command-entry method you find easi-

est, another way to begin the command is to recall it. To recall past entries or the 

last command entered (Figure 1.31), do the following:

 1. Right-click or press the Enter key. A tooltip window will display, enabling you 

to recall the last command and give you the option to choose from previously 

entered commands.

 2. Hover your cursor over the option to select and click it with the left mouse 

button.

FIGURE 1.31:  Ω The Recall Command 
Entry tooltip window

Unit Entry

When the drafting units of your drawing are set to architectural, AutoCAD will rec-

ognize any numerical entry as inches. For example, to draw a line that is 2´-6 ,̋ the 

command-line entry would be either 2´6˝ or 30 .̋
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AutoCAD Drawing File

The information in the AutoCAD Save Changes window shows the path to where 

your drawing is saved. If you selected the Yes option, your drawing was saved and 

closed to the location you originally designated. The suffix appended to all AutoCAD 

drawings is .dwg. (See Figure 1.33.)

FIGURE 1.33:  Ω The AutoCAD File icon

AutoCAD Backup Drawing File

Backup AutoCAD files are created in the same folder as the original drawing. The 

suffix that is appended to these drawings is .bak. These files can be useful if the 

original file becomes corrupt. The backup file can be renamed by changing the suffix 

from .bak to .dwg. Once done, the drawing file can be opened and used. All of the 

work completed at the time the drawing was last saved and closed should be avail-

able. (See Figure 1.34.)

FIGURE 1.34:  Ω The AutoCAD 
Backup File icon
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Acad, 4.  See also Drawing templates
Acad.dwt, 4.  See also Drawing templates 
Acad files (*dwg, *.dxf), 165
Adcenter, 92 
Adding layers to an AutoCAD drawing, 68–72
AIA layer naming standard, 92
Aligned dimension command/icon, 62
Alignment field (new table style window), 88
All programs, 2
Angled Window block (base plan), 44
Angle field (insert window), 44
Angular dimension command/icon, 62–63
Arc command/icon:

AutoCAD, 20
Google SketchUp, 156–157

Arch C paper size—18”x 24” (large format paper sizes for plotters), 122
Arch D paper size—24”x 36” (large format paper sizes for plotters), 122
Arch E paper size—36”x 48” (large format paper sizes for plotters), 122
Arch E1 paper size—30”x 42” (large format paper sizes for plotters), 122
Architectural ticks, 56
Architectural units, 5, 12
Array command/icon, 79–81
Array Window, 80

method and values section, 80
Polar Array option, 80
Polar Array Pick Center Point icon, 80
Polar Array Select Objects icon, 80
Total Number of Items field, 80

Arrowheads Section (New Dimension Style window—Symbols and Arrows tab), 
55

Arrow Size (New Dimension Style window—Symbols and Arrows tab), 51

Assigning objects to appropriate layers, 72–74
Attdef, 125
Attach Drawing icon (External References window), 101
Attribute Definition window, 125

Attribute section, 126–127
Date and Scale Attribute (Editable Attributes), 126
Default field, 125–127
Drawing Number Attribute (Editable Attributes), 127
Justification field, 126–127
Mode category, 125–127
Prompt field, 125–127
Tag field, 125–126
Text Height field, 126–127
Text Settings category, 126–127
Verify box, 125–127

Attribute section (Attribute Definition window), 126–127
Attributes, 125 
Attribute values (Layout tab), 129
AutoCAD Classic Workspace, 3
AutoCAD Design Center Online command/icon, 92–94
AutoCAD Drawing file (.dwg) extension/icon, 11
AutoCAD interface, 6
AutoCAD text window, 19
Autodesk folder, 2
Available Toolbar Menu, 8
Axes—X, Y, Z , 150, 152

B

Back Up Drawing file(.bak) extension/icon,10
Base Plan:  

built-in millwork, 46

Index
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closets, 45–46
fireplace, 46
hatch, 47
suggested layer list for the Base Plan, 68

Base Point field (Block Definition window), 37
Basic Core Commands:

AutoCAD, 13–30
Google SketchUp, 153–164

Basic Drafting settings, 14–15
Before layout field (Move or Copy layout tab window), 142
Blocks:

Angled Window block, 44
Closet Door block, 45–46
inserting blocks, 40, 128–130
Main Entrance block, 38–39
making blocks, 35
Window block  35–36
write blocks, 41

Block Definition window, 37
Base point field, 37
Name field, 37
Objects field, 37
Pick Point icon, 37–38
Select Objects icon, 37

Block Insert window, 44
Block Library, 41
Boundaries field (Hatch and Gradient window), 48
Brick_Rough_Dark Option (Materials Window—Google SketchUp), 158–159
Built-in Millwork (Base Plan), 46

C

Camera pulldown menu, 164
Standard Views, 164
Top View option, 164

Cell Styles (Table Style window), 88
Center Object Snap, 14–15
Circle command/icon:

AutoCAD, 23
Google SketchUp, 155–156

Chair folder (Design Center Online), 93
Classic Workspace, 3
Close:

an AutoCAD drawing, 10

a Google SketchUp drawing, 173
Closed polyline, 20
Closet Door block (Base Plan), 40–41
Closets:

Base Plan, 45–46
Google SketchUp, 170–171

Color field (Layer Properties Manager window), 69
Column field (Table Insert command), 89
Column and Row settings (Table Insert command), 89
Command entry, 7–8
Command line, 7
Commands:

clearing, 9
repeating, 9

Completed elevations, 118–119
east elevation, 119

north elevation, 118
south elevation, 119
west elevation, 119

Components:
AutoCAD User Interface, 6–10
Google SketchUp, 171–172

Conference Chair block (Design Center Online), 93
Continuous Linear Dimension command/icon, 60–61
Control buttons, 6
Copy command/icon, 24–25 
Copy Layout tab, 141–142
Copy/Paste command/icon, 161
Core commands (Google SketchUp), 152–164
Cove Ceiling (Base Plan), 78–81
Create button (Create Component window), 171
Create Component window, 171

Name field, 171
Create New Dimension Style window, 54–57

Fit Tab window, 56
New Style Name field, 55
Primary Units Tab window, 56–57
Symbols and Arrows Tab window, 55
Text Tab window, 56

Create New Table Style window, 87
Creating the Electrical Plan legend, 95–96
Creating the Lighting Plan legend, 89–91
Creating a New Dimension Style, 54–57
Creating a New Text Style, 53–54
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Creating a Template file, 131–132
File Name field, 131
Files of Type field, 131
Template folder, 132

Creating a Titleblock, 122–130
Creating a Two Dimensional graphic, 172
Crosshairs, 7
Current drawing name, 6

D

Data Text Cells (Table Insert command), 91
Date attribute, 126–127
DC Online tab (Design Center Online window), 93
Ddunits, 4
Default field (Attribute Definition window), 125–127
Default Number of Columns field (Table Insert command), 89
Default Width of Columns field (Table Insert command), 89
Defpoints, 134
Delineated elevations, 106, 111, 114–115

east elevation, 111
north elevation, 106
south elevation, 114
west elevation, 115

Design Center Online, 35, 92–94
Chair folder, 93
Conference Chair block, 93
Desk Chair block, 93
Duplex block, 94
Electrical folder, 94
Electrical Outlet block (110 Volt), 94
Electrical Power folder, 94
Floor Lamp block, 94
Furniture folder, 93
Lamps folder, 94
Outside Phone block, 94
Seating folder, 93
Space Planning folder, 94
Square Table (20”) block, 94
Standard Parts category, 93
Table folder, 93
Telephone folder, 94
Two Dimensional Architectural folder, 93
Wiring folder, 94

Design Center Online icon, 92
Design Center Online window, 93
Desk Chair Block (Design Center Online), 93
Destination field (Write Block Definition window), 42
Diameter Dimension command/icon, 83–84
Dimaligned, 61
Dimangular, 61
Dim-24 Dimension style, 117
Dim-48 Dimension style, 54–57
Dimcontinue, 61
Dimensioning:

adding dimensions to a drawing, 59–65
creating a New Dimension style, 54–57, 117
stretching a Dimension String, 54–57
typical dimensions, 59, 64–65

Dimension Style command/icon, 54–57
Dimension Style control window, 58, 117
Dimension Style Manager window, 54, 57

Linear Dimension field, 56
New button, 55
Dimension Toolbar, 59
Dimension Types:

Aligned Dimension command/icon, 62
Angular Dimension command/icon, 62–63
Continuous Linear Dimension command/icon, 60–62
Diameter Dimension command/icon, 83–84
Linear Dimension command/icon, 59

Dimlin, 61
Dimstyle, 54
Docked Toolbars, 8–9
Door Headers, 81
Download Google SketchUp 6, 150–151
Download Google SketchUp button, 150
Drag and Drop, 93
Draw Pulldown Menu, 20
Drafting Setting window, 15
Drawing A1—Plan, 134
Drawing A2—Reflected Ceiling Plan, 134
Drawing A3—Electrical Plan, 134
Drawing File Extensions, 10–11
Drawing Lines at a Precise Distance and Angle, 18–19
Drawing Limits, 5
Drawing Name symbol, 128
Drawing Number Attribute, 127
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Drawing Orientation Category (Page Setup Manager window), 141
Drawing Symbols, 128–130

Drawing Name symbol, 128
Elevation Tag symbol, 128
North Arrow symbol, 128
Section Detail Tag symbol, 128

Drawing Templates:
Acad, 4
Acad.dwt, 4

Drawing the Titleblock Boundaries, 123–124
Draw Toolbar, 6
Drawing Units window, 5

Length Category/Section, 5
Type field, 5

Duplex Block (Design Center Online), 94
Dynamic button, 14
Dynamic Input, 15
Dynamic Input window, 15

E

East Section/Elevation, 110–114
Edit Pulldown Menu  21–22
Editable Attributes, 125–130

Attribute Section, 126
Date and Scale Attribute, 126
Drawing Number Attribute, 127
Mode Section, 125–127
Text Settings, 126–127
Updating Editable Attributes, 130

Editable text, 125–127
Edit Pulldown Menu, 171

Make Component window, 171
Electrical Folder (Design Center Online), 94
Electrical Outlet Block—110 Volt (Design Center Online), 94
Electrical Plan, 94–97

Creating the Electrical Plan Legend, 95–96
Managing Electrical Plan Layers, 96–97

Suggested Layer List for the Electrical Plan, 96
Updating the Electrical Plan Legend, 95–96

Electrical Power Folder (Design Center Online), 94
Electrical Wiring Folder (Design Center Online), 94
Elevation Tag symbol, 128
Elevations (see Interior Sections and Elevations)

Endpoint Object Snap, 14–15
Enhanced Attribute Editor window, 130

Value field, 130
Erase command/icon:

AutoCAD, 29
Google SketchUp, 157–158

Explode command/icon, 123–124
Exporting Elements from the Drawing File, 172–173
Export Option, 172
Export Two Dimensional Graphic, 173
Export Type Field (Export 2D Graphic—Google SketchUp), 173
Extend command/icon, 29
External References command, 100–104

Binding an External Reference, 103–104
Controlling Layers within an External Reference, 104
External Reference Action Option Tooltip window, 103
Managing External References, 102–104
Refresh External Reference icon, 103

External References window, 101
Attach Drawing icon, 101
Select Reference File window, 102

External Reference Has Changed Message, 102
Extruding Geometry, 169

F

File Name Field:
Creating Template file, 131
Save Drawing as window, 4
Save PDF File as window, 146
Select Template window, 4

Files of Type Field (Creating Template file), 131
Files of Type Options (Open window), 165
File Pulldown Menu, 4, 172
Files:

Naming AutoCAD Drawing files, 7
Sharing AutoCAD Drawing files, 146–147
File Types:

Image files (.pdf), 146
Plot files (.plt), 146

Fireplace (Base plan), 46–47
Fit Tab (New Dimension Style window), 56

Scale for Dimension Features section, 56
Use Overall Scale of Field, 56
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Floating Toolbars, 9
Floor Lamp block (Design Center Online), 94
Floor Plan Boundaries, 42–48
Floor Plan Dimensioned, 64
Flyout menus, 9
Flyout menu marker, 9
Font Name (Text Style window), 43–54
Format Pulldown menu, 5
Freeze or Thaw in Current Viewport icon, 138
Freezing Layers in an Active Viewport, 137–138
Freezing Layers via the Layer Properties Manager Shortcut window, 138
Furniture Folder (Design Center Online), 93

Chair folder, 93
Table folder, 93

Furniture Plan, 92–94
Managing the Furniture Layers, 94

Sugested Layer List for the Furniture Plan, 94

G

General Tab (New Table Style window), 88
Google SketchUp Download page, 151
Google SketchUp 6 (free) Download window, 151
Google SketchUp Home page, 150
Google SketchUp icon, 151
Google SketchUp, 150–173

Creating a 2D Graphic, 172
Close and Save a Google SketchUp Drawing, 173
Downloading Google SketchUp 6, 150–151
Extruding Geometry, 169
Healing Geometry, 168
Importing an AutoCAD Drawing file, 164–166
Launching a New Google SketchUp Session, 151–152

Google SketchUp Interface, 152–164
Axes, 152
Components, 171–172
Core Commands, 152–164
Inference Points, 152

Information Window, 156
Google SketchUp Pro 6, 150
Grayscale.ctb, 141
Grips, 20–21

H

Hatch (Base Plan), 48
Hatch command/icon, 47
Hatch and Gradient window, 48

Boundaries field, 48
Pick Internal Point Field icon, 48
Type and Pattern field, 48

Header Option (New Table Style window), 88
Header Text Cell (New Table Style window), 90
Heads Up Design, 15
Healed Geometry, 168
Horizontal Floor Plan boundaries, 43

I

Image Files (.pdf ), 146
Import Results window, 166
Importing an AutoCAD Drawing into Google SketchUp, 165–166
Inference Point, 1 54
Infilled Walls, 167
Information Box, 156
Insert Block command/icon, 43
Insert window:

Angle field, 44
Name field, 44
Rotation field, 44

Inserting blocks, 44, 128–130
Inserting the Main Entrance block, 43
Inserting the Window block, 44
Identifying Line Segments as Polylines, 124
Information Center, 6
Inserting Blocks Into Layout Space, 128–130
Interacting with AutoCAD, 7–10
Interior Closets, 45–46
Interior Sections and Elevations, 105–119

Adding Hatch, 110
Adding Notes and Dimensions, 116–119
Drawing Base and Crown Molding, 109–110
Drawing the Closet Doors, 113
Drawing the Cove Ceiling, 107–108
Drawing the Desk, 115–116
Drawing the East Section/Elevation, 110–114
Drawing the Fireplace, 112
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Drawing the Light Fixtures, 81–82, 106–107
Drawing the Main Entry Door, 114–115
Drawing the North Section/Elevation, 105–110
Drawing the South Section/Elevation, 114–115
Drawing the West Section/Elevation, 115–116
Drawing the Windows, 106–107, 111–112
Suggested Layer List for the Interior Sections/Elevations, 105

Intersection Object Snap, 14–15

J

Justification Field (Attribute Definition window), 126–127

L

Lamps Folder (Design Center Online), 94
Large Format Paper Sizes for Plotters,122

Arch C—18”x 24”, 122
Arch D—24”x 36”, 122
Arch E—36”x 48”, 122
Arch E1—30”x 42”, 122

Launching AutoCAD, 2–3, 14, 34
Launching Google SketchUp, 151–152
Layers:

Adding Layers to an AutoCAD Drawing, 68–72
AIA Layer Naming Standard, 92
Assign Object to appropriate layer, 72–74
Layer Color/Lineweight window, 70
Layer Short Cut window, 74
Managing layers, 74–75
Manipulating layers, 74 
New Layer Line Entry, 69
Select Layer Color window, 69
Select Layer Lineweight window, 70
Select Linetype window, 71

Layer Color/Lineweights Table, 70
Layer Color/Lineweights window, 70
Layer Properties Manager, 7, 68–72
Layer Properties Manager icon, 69
Layer Properties Manager Shortcut window, 68, 74

Xref Layers example, 104
Layer Properties Manager window, 69

Color field, 69
Linetype field, 71

Lineweight field, 70
Name field, 69
New Layer icon, 69
Set Current Layer icon, 75

Layer Shortcut window, 68
Layers Toolbar, 7
Layout Space, 134–142

Managing Layout Tabs, 139–142
Layout Tabs, 6, 141–142
Layout 1 Tab (Active), 129
Learning Center window, 151
Left to Right Selection Sets, 23–24
Legal Page Size—8 ½”x 14”, 122
Length Section (Drawing Units window), 5
Letter Page Size—8 ½” x 11”, 122
Light Switch Locations and Controls, 86–87
Lighting Plan Legend, 89–91
Line command/icon:

AutoCAD, 16
Google SketchUp, 153–154

Linear Dimension command/icon, 59
Linear Dimension Field (Dimension Style Manager window), 57
Lines, drawing lines at a Precise Distance and Angle, 18–19
Linetype Field (Layer Properties Manager window), 69

Linetype Scales, 73–74, 134
Linetype Scales Table, 73
Lineweight Mode button, 15
Lineweights:

Lineweight Mode button, 15
Viewing Lineweights, 15, 71

Lineweight Field (Layer Properties Manager window), 69
Lineweight window, 70

List Command, 19
Load Button (Select Linetype window), 71–72
Load or Reload Linetypes window, 72
Living Room floor plan, 52
Ltscale, 73
Lwt, 71

M

Main Entrance block, 38–39
Make Block command/icon, 37–38
Make Component window, 171
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Making Blocks, 35
Managing Ceiling Plan layers, 91–92
Managing Electrical Plan Layers, 96–97
Managing Furniture Plan Layers, 94
Managing Layers, 67–75
Managing Layers in a Viewport, 136–138

Expanded Layer Properties Manager window, 137
Freezing Layers via the Layer Properties Manager Shortcut window, 138
Freezing Layers within a Viewport, 137

Managing Layout Tab, 139–142
Managing Reflected Ceiling Plan Layers, 91–92
Maneuvering the User Interface, 6–7
Manipulating Layers, 74
Matchprop, 73 
Match Properties command/icon, 73
Material Selection (Materials window), 158–159
Materials window, 158–159
Method and Values Section (Array window), 80
Middle Mouse Button, 7
Midpoint Object Snap, 14–15
Mirror command/icon, 30
Mode Category (Attribute Definition window), 125–127
Model Space, 8
Model Space tab, 7
Modify Button (Page Setup Manager window), 139
Modify Pulldown Menu, 24
Modify Toolbar, 7
Monochrome.ctb, 141
Move command/icon

AutoCAD, 26–27
Google SketchUp, 161

Move or Copy Layout Tab window, 142
Before Layout field, 142
Move to End option, 142

Multiline Text command/icon, 58

N

Name Field:
Block Definition window, 37
Create Component window, 171
Insert window, 43
Layer Properties Manager window, 69
Page Setup Manager window, 140

Naming AutoCAD files, 7
New Button (Dimension Style Manager window), 54
New Dimension Style window, 55–56

Fit tab, 56
Primary Units tab, 57
Symbols and Arrows tab, 55
Text tab, 55–56

New Drawing icon, 3
New Features Workshop, 3
New Drawing Session, 3–5
New Layer Icon (Layer Properties Manager window), 69
New Layer Line Entry (Layer Properties Manager window), 69
New Style Name Field (Create New Dimension Style window), 54–57
New Table Style window, 88

Alignment field, 88
Cell Styles category, 88
Close button, 88
General tab, 88
Header Option, 88
Header Text cell, 90
Properties category, 88
Set Current button, 88
Text Style field, 88
Title option, 88

New Text Style window, 54
Style Name field, 54

North Arrow symbol, 128
North Section/Elevation, 105–110

Notes, adding to elevations, 116–119

O

Object Snaps, 12
Objects Field (Block Definition window), 38
Offset command/icon

AutoCAD, 27–28
Google SketchUp, 162–163

Orbit command/icon, 160
Ortho, 14
Orthogonal Mode button, 14
Open window, 165

Files of Type Options, 165
Osnap Button, 14

Setting Running Osnaps in an AutoCAD Drawing, 14
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Outlining the Floor Plan Boundaries, 42
Outside Phone Block (Design Center Online), 94

P

Page Setup Manager, 139–142
Page Setup Manager window:

Drawing Orientation, 141
Modify Button, 139
Name field, 140
Paper Size, 140
Plan window, 140
Plot Area, 140
Plot field, 140
Plot Offset, 140
Plot Scale, 141
Plot Style Table (Pen Assignments), 141
Printer/Plotter, 140
Scale field, 141
Scale Lineweights, 140

Pan Realtime command/icon:
AutoCAD, 17
Google SketchUp, 163

Paint Bucket command/icon, 158–159
Paint Bucket Materials window, 158

Paper/Page Sizes, 122
Paper Size (Page Setup Manager window), 140
PDF Files, 146
Perpendicular Object Snap, 14–15
Phone Interconnect block (Design Center Online), 94
Pick Point Icon (Block Definition window), 37
Pick Internal Point Field Icon (Hatch and Gradient window), 48
Plan Drawings, 134

Drawing A1—Plan, 134
Drawing A2—Reflected Ceiling Plan, 134
Drawing A3—Electrical Plan, 134

Plan Window (Page Setup Manager window), 140
Plants Folder (Design Center Online), 94
Plant 1 Block (Design Center Online), 94
Plot Area (Page Setup Manager window), 140
Plot Files, 146
Plot—Plan Tab window, 142
Plot Preview:

Plot—East Elevation Preview tab, 145

Plot—Electrical Plan Preview tab, 144
Plot—Furniture Plan Preview tab, 144
Plot—North Elevation Preview tab, 145
Plot—Plan Preview tab, 143
Plot—Reflected Ceiling Plan Preview tab, 143
Plot—South Elevation Preview tab, 145
Plot—West Elevation Preview tab, 145

Plot Scale (Page Setup Manager window), 141
Plot Style Table—Pen Assignments (Page Setup Manager window), 141
Polar Array command, 80
Polar Array Option (Array window), 80
Polar Array Pick Center Point icon (Array window), 80
Polar Array Select Objects Icon (Array window), 80
Polygon command/icon, 78–79
Preview Button (Page Setup Manager window), 141 
Primary Units Tab (New Dimension Style window), 55

Linear Dimension Field, 59
Unit Format Field, 56

Printer/Plotter Category (Page Setup Manager window), 140
Print/Plot command/icon, 142–147
Project Name Attribute of Titleblock, 126
Prompt Field (Attribute Definition window), 125–127
Properties Category (New Table Style window), 88
Properties command/icon 63–64
Properties window, 63

Text tab, 64
Text Override field, 64

Protractor, 161
Psltscale, 134
Pulldown Menu, 6
Push/Pull command/icon, 160

Q

Quadrant Object Snap, 14–15
Quick Leader command, 117–118

R

Radio buttons, 14
Recessed Light Fixtures, 81–82
Rectangle command/icon:

AutoCAD, 20
Google SketchUp, 154–155
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Redo command/icon:
AutoCAD, 22
Google SketchUp, 157–158

Reflected Ceiling Plan (RCP), 78–92
Adding Dimensions and Text, 82–86
Adding Light Switch Locations and Controls, 86–87
Creating a Lighting Legend, 89–91
Drawing the Recessed Light Fixtures, 81–82

Managing RCP Layers, 91–92
Updating the Lighting Legend, 89–91
Refresh External Reference icon, 103
Rename the Layout tab, 139
Repeating Command Entries, 9–10
Right to Left Selection Sets, 21–22
Rotate command/icon:

AutoCAD, 25–26
Google SketchUp, 161–162

Rotation Angles, 25
Rotation Field (Insert window), 44

S

Save Changes window:
AutoCAD, 10
Google SketchUp 173

Save Drawing As window, 4
File Name field, 4
File Name field (Creating a Template file), 131
Files of Type field (Creating a Template file), 131
Template Folder (Creating a Template file), 132

Save PDF File As window, 146
File Name field, 146

Saving a New AutoCAD Drawing file, 14
Scale Attribute, 126–127
Scale Factors, 52
Scale field (Page Setup Manager window), 140
Scale for Dimension Features Section (New Dimension Style window), 54

Use Overall Scale of Field, 54
Scale Lineweights Box (Page Setup Manager window), 140
Seating Folder (Design Center Online), 93
Section Detail Tag symbol, 128
Select Color Window (Layer Properties Manager window), 69
Select Layer Color window (Layer Properties Manager window), 69
Select Layer/Lineweight Window (Layer Properties Manager window), 70

Select Linetype Window (Layer Properties Manager window), 68
Load button, 72
Load/Reload Linetype window, 72

Select  command/icon, 153
Select Objects Icon (Block Definition window), 37
Select Reference File window (External References), 102
Select Template window, 4

File Name field, 4
Selection windows, 23–24

Left to Right Selection window, 23
Right to Left Selection window, 24
Single Mouse Pick selection, 24

Set Current Button (New Table Style window), 88
Set Current Layer Icon (Layer Properties Manager window), 72
Set Scale Control (Viewport), 135
Set Scale Control Window Scale Option window, 136
Setting Drawing Limits, 5
Setting Drawing Units, 4–5
Setting Running Object Snaps in an AutoCAD Drawing, 14
Sharing the Drawing file, 146–147
Short Cut icon:

AutoCAD, 2
Google SketchUp, 151

Single Mouse Pick Selection , 24
Single Viewport command/icon, 135 (see Viewports)
Software Control buttons, 6
Source Field (Write Block Definition window), 41
South Section/Elevation, 114–115
Space Planning folder (Design Center Online), 94
Square Table (20”) block (Design Center Online), 93
Standard Google SketchUp Toolbar, 152
Standard Paper Sizes for Small Format printers, 122

Legal Size—8 ½”x 14”, 122
Letter Size—8 ½”x 11”, 122
Tabloid Size—11”x 17”, 122

Standard Parts Category (Design Center Online), 93
Standard Views, 164
Starting a New AutoCAD Drawing Session, 3–5

Save As Function, 4
Selecting a Template, 4
Setting Drawing Limits, 5
Setting Drawing Units, 4

Start Menu, 2
Standard Toolbar, 6
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Status Toolbar, 6–7, 14–15
Settings, 34

Stretching a Dimension String with Grips, 60
Stretching Geometry with Grips, 20–21
Style Name Field (New Text Style Window), 54
Styles Toolbar, 54

Dimension Style icon, 54
Text Style icon, 49

Suggested Layer List for the Base Plan, 68
Suggested Layer List for the Electrical Plan, 96
Suggested Layer List for the Furniture Plan, 94
Suggested layer List for the Interior Sections/Elevations, 105
Symbols and Arrows Tab (New Dimension Style: dim-48 window), 55

Arrowheads section, 55
Arrow Size field, 55

T

Tabs, Model Space and Layout tabs, 129
Table 48, 88
Table Style command/icon, 87
Table Style Control window, 88
Table Style window, 87

Create a New Table Style window, 87  
Cell Styles, 88

Table Insert command/icon, 89
Column field, 89
Column and Row Setting Category, 89
Data Text cells, 91
Default Number of Columns field, 89
Default Width of Columns field, 89

Table Folder (Design Center Online), 93
Tabloid Paper Size—11”x 17”, 122
Tag Field (Attribute Definition window), 125–127
Tape Measure command/icon, 158–159
Telephone Folder (Design Center Online), 94
Template files:

Starting a New AutoCAD Drawing, 4
Creating a Template file, 131–132

Template Folder (Creating a Template file), 132
Template Options window, 132
Text:

Adding Text to an AutoCAD Drawing, 57–58
Creating a Text Style, 53–54, 116

Text-24, 116
Text-48, 53–55
Text Appearance (New Dimension Style window), 55
Text Formatting window, 58
Text Height, 52–53
Text Height (Attribute Definition window), 126–127
Text Heights Table, 52
Text Override Field (Properties window), 63
Text Settings (Attribute Definition window), 126–127
Text Style command/icon, 53–54
Text Style field (Table Style window), 88
Text Style (New Dimension Style window), 55
Text Style Control window, 54
Text Styles Icon (Styles Toolbar), 53
Text Style window, 53

Font Name, 53–54
Text tab (New Dimension Style window), 55–56

Text Appearance field, 55–56
Text style, 55–56

Text tab (Properties window), 63
Text tab (Table Style window), 88
Text window, 19
Three Button mouse, 9
Title Option (New Table Style window), 88
Titleblocks:

Adding Editable text, 125–127
Creating a Titleblock, 122–130
Titleblock Boundaries, 123–124

Titleblock Inserted in Layout tab, 130
Titleblock with Drawing Symbols Inserted, 130
Titleblock with Updated Drawing Attributes, 130
Tooltip Identification windows, 8, 153
Top View Option, 164
Total Number of Items field (Array window), 80
Trim command/icon, 28
Two Dimensional Architectural Folder (Design Center Online), 93
Two Dimensional Drafting and Annotation Workspace (AutoCAD), 3
Two Dimensional Graphic Option, 172
Two Dimensional Graphic window, 173

Export Type Field, 173
Typ, 59
Type and Pattern Field (Hatch and Gradient window), 48
Type Field (Drawing Units window), 5
Typical Dimensions, 53, 59
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Typical Dimensions (Elevations), 117
Typical Notes (Elevations), 117
Typical Paper and Page Sizes, 122
Typical Rotation Angles, 25

U

UCS, 6–7
Undo command/icon:

AutoCAD, 21
Google SketchUp, 157–158

Units, 4
Unit Entry, 10
Unit Format Field (New Dimension Style window), 55
Updating Editable Attributes, 130
Updating the Electrical Plan Legend, 95–96
Updating the Light Plan Legend, 89–91
Use Overall Scale of Field (New Dimension Style window), 55
User Interface, 5–10

V

Value Field (Enhanced Attribute Editor window), 130
Verify Box (Attribute Definition window), 125–127
Vertical Boundary Delineation of the North Elevation, 105
Vertical Floor Plan Boundaries, 42
Viewing Linetypes, 13, 69
Viewing Lineweights, 115
Viewport Toolbar, 134
Viewports, 134–138

Single Viewport Command, 135
Setting the Scale of a Viewport, 135–136
Managing Layers within a Viewport, 136–137

Viewport Freeze column, 137
View Pulldown menu, 16–18
Vports, 135

W

West Section/Elevation, 115–116
Window Block, 35–37

Wiring folder (Design Center Online), 94
Workspaces:

AutoCAD Classic Workspace, 3
2D Drafting and Annotation Workspace, 3

Wblock command, 41
Write Blocks, 41 
Write Block Definition window, 41

Destination field, 42
Source field, 42

X

X Axis, 150, 152
Xref Action Option Tooltip window, 103
XREF (see External References)

Y

Y Axis, 150, 152

Z

Z Axis, 150, 152
Zoom command/icon:

AutoCAD, 16–18
Google SketchUp, 163

Zoom All command/icon, 16
Zoom Extents command/icon

AutoCAD, 16–17
Google SketchUp, 164

Zoom In command, 17
Zoom Out command: 

AutoCAD, 17
Google SketchUp, 163

Zoom Scale command/icon, 18
Zoom window command/icon, 18
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